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Welcome to Full Tilt!

This is as real as it gets—a truly realistic pinball experience on a
computer. Full Tilt! Pinball is just like playing in an arcade, but with
no missing balls, no broken flippers, no burnt-out lights, and NO
DOGGONE QUARTERS—nothing but fast action, pulsating music,
exciting sound effects and craftily-designed, great-looking, fast-
playing pinball tables. Period.

Full Tilt! Pinball includes three great pinball tables: Space Cadet—a

- modified, improved version of the table that is included in the
- Microsoft Plus! companion for Windows 95; plus Skulduggery and
,{e - Dragon’s Keep—brand new, never-before-played tables.

- All tables accommodate up to four players, include multiball play

~ and are 3-D rendered in multiple resolutions to look their best on
~ any computer. And to make the play its best, we've outlawed
~ scrolling tables, and included three-way table nudging.

About This Manval and the Additional Electronic Docs

This here printed pile of paper will help you get Full Tilt! installed
and started. It will also give a little info on mission-based pinball
and scoring, as well as the basics of controlling the Full Tilt! tables.

You can also access on-screen help while Full Tilt! Pinball is running
in a window (not in Full Screen Mode) by pressing the F1 key or
selecting Contents from the Help menu in Windows 95 or Windows
3.1, or by opening the Help menu (it’s the question mark icon) on
Macintosh computers and selecting About Full Tilt.
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Installing and Starting Full Tilt!

Installing and Starting Full Tilt! for Your Macintosh

Full Tilt! will run on any Macintosh Quadra 650 or above, Power
Macintosh 7100 or above, and PowerBook 180c or above. You also need
at least 8MB of RAM, System 7.0 or better, a CD-ROM drive, 25 MB on
your hard drive, and a monitor that displays 256 colors or gray scale.

To get started, put the Full Tilt! CD into your CD-ROM drive. The CD will
open and display the Full Tilt! folder. Drag the Full Tilt! folder to your
hard drive. That'’s it!.

To play Full Tilt!, open the Full Tilt! folder and double-click the Full Tilt!
program. This will let you choose the table you want to play from a Full
Tilt! opening screen. You can also double-click on a specific table icon to
load and play that table.

Note: We recommend that you turn off any network connections before
playing Full Tilt!

Basic Controls

Full Tilt! Pinball is controlled with a few keys of your keyboard. Here are
the controls and their default keys:

Left Flippers—z

Right Flippers—/

Bump Table Left—v
Bump Table Right—n
Bump Table Bottom—b
Launch Ball—space bar
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To change any or all of these controls, open the Options menu and
select Player Controls. Click on the control you want to change and
press the key you want for that control.

There are also some useful keyboard shortcuts for game options:

Start New Game - 38N
Launch Ball - 8L
Pause/Resume Game - 88P
Quit Game - 88Q

Toggle Sounds - 8S
Toggle Music - 8M
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Installing and Starting Full Tilt! for Windows 95
Requires Windows 95

486 DX or above

8MB RAM

23MB of hard drive space for complete installation
2x CD-ROM drive

Installation and starting is simple:

Pop the Full Tilt! (D into your (D drive.

If your CD-ROM drive supports AutoPlay, you'll see the AutoPlay screen.
Click on the Play button. Full Tilt! will automatically install itself the first
time you play it. Afterwards, Full Tilt! will appear in your Start menu,
under Programs\Maxis.

If your CD-ROM drive does not support AutoPlay open the Start menu,
select Run..., and type in D:\Setup (or E:\Setup depending on what
letter is assigned to your CD-ROM drive), and click OK. Full Tilt! will
install, and henceforth appear in your Start menu, under
Programs\Maxis.

After it has been run once from AutoPlay or installed from the CD, you
can start Full Tilt! from either the AutoPlay screen or the Start menu.

Note: When you start Full Tilt! from the Start menu, be sure you have the
Full Tilt! CD in your CD drive if you selected partial installation.
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Basic Controls

Full Tilt! Pinball is controlled with a few of the keys on the keyboard.
Here are the default keys:

Space Bar — Hold it to pull out the plunger, release it to shoot the ball
Z — Activate left flipper (or flippers)

| — Activate right flipper (or flippers)

X — Bump table to right

.— Bump table to left

Up-Arrow — Bump table up

You can change these keys to suit your playing style by selecting Player
Controls in the Options menu.

Here are some additional useful keyboard shortcuts:

F1 — Opens the electronic documentation/Help to the contents page
F2 — Starts a new game

F3 — Pauses/Unpauses the game

F4 — Toggles between Full Screen and Window mode

F8 — Opens Player Controls
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Installing and Starting Full Tilt! for Windows 3.1
Requires Windows 3.1 or Windows 3.11

486 DX or above

23 MB of hard drive space for complete installation
8 MB RAM

2x CD-ROM Drive
Graphics card and monitor capable of displaying 640 x 480 x 256 colors
(512K video RAM)

Supports most Windows compatible sound cards

You can play Full Tilt! directly from the CD, or put everything on your
hard drive. Playing from the CD will only require about 50 KB of hard
drive space, but game tables will load more slowly. Putting everything
on your hard drive will require about 23 MB of hard drive space, but
tables will load faster. Either way, a few files must be installed to your
hard drive before you can play. Here’s what you do:

Iy

22
Sk
4

S

Start Windows and open the Program Manager.

Put the Full Tilt! CD into your CD-ROM drive.

Open the Program Manager File menu and select Run....

In the box under the words “Command Line:” type D:\SETUP

[enter]. Don’t forget the colon! If your CD-ROM is some letter
other than “D”, use that letter instead.

Click OK.

Follow instructions on the screen. During installation, you will be
able to change the directory where Full Tilt! is installed. The
default directory is C:\MAXIS\FULLTILT. You can also choose
between Full and Partial installation. A Maxis Program Group will
be created (if you don’t already have one), and the Full Tilt! icons

User's Manual




will be placed into this group.
To start Full Tilt! open the Program Group where Full Tilt! was installed
- (the default is Maxis). To load and play one specific table, double-click
its icon. To turn your computer into a full fledged arcade, double-click
the Full Tilt! icon. This will allow you to select your tables from a menu.

Basic (ontrols
~ Full Tilt! Pinball is controlled with a few of the keys on the keyboard.
- Here are the default keys:
Space Bar — Hold it to pull out the plunger, release it to shoot the ball
Z — Activate right flipper (or flippers)
,":ef ’ | — Activate left flipper (or flippers)
' X — Bump table to right
. — Bump table to left
Up-Arrow — Bump table up
You can change these keys to suit your playing style by selecting Player
Controls in the Options menu.
Here are some additional useful keyboard shortcuts:
F1 — Opens the electronic documentation/Help to the contents page
F2 — Starts a new game
F3 — Pauses/Unpauses the game
F4 — Toggles between Full Screen and Window mode
F8 — Opens Player Controls

Full Tilt!



Setting 256-Color Mode
Full Tilt! has beautiful 256-color graphics. That’s the good news. The bad
news is that you may have to change your video display driver to run it.

If you're currently running in 256 colors or more, then you're ready to
play. If you're currently running in a 16-color mode (like the standard
VGA driver that comes with Windows), then you’ll need to change your
driver. If you know you need to change your driver (or aren’t sure) then
follow these steps: '

Big, big warning!!! Don’t install the wrong kind of driver! Windows
ships with a lot of drivers that will NOT work on your computer. In
particular, DO NOT INSTALL THE VIDEO 7 DRIVER UNLESS YOU ARE
ABSOLUTELY SURE YOU HAVE A VIDEO 7 VIDEO CARD!!! 6

1. First check to see what kind of video card you have. If you have a
fairly new one, it may have its own program for changing color
settings. If it does, then see the instructions that came with the
card and set it to 256 colors (any resolution from 640 x 480 to
1280 x 1024 is OK, as long as it has 256 colors.) If your card
doesn’t have its own program for setting video modes, then
proceed with step 2.

2. Locate all your original Windows disks and any disks that came
with your video card. These will have the driver you need (and
more) on them. Don’t do anything with them yet, just keep them
handy.

3. Start Windows and open the Program Manager.

4. Double-click on the Windows Setup icon. (It’s usually in the Main
program group.)
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When the Windows Setup Dialog opens, look at the listed display.
If it’s just plain VGA or says something about 16 colors ore more
than 256 colors, then you need to change your driver. If it says
256 colors, then you don’t need to change anything. Quit
Windows Setup and start playing.

If you need to change your driver, then open the Options menu
and select Change System Settings.

When the Change System Settings dialog box opens, click on the
down-arrow on the right of the Display listing. A list of different
display driver options will open. Scroll down the list and look for
an “SVGA 640 x 480 x 256" driver. If it’s there, click OK. If it isn’t
there, select Other display and skip to step 12.

If the driver is already on your hard drive, you will be asked if
you want to use the currently installed driver or install a new
one. Click Current.

Click Restart Windows, and you're ready to play. You can skip
the rest of this section.

If the driver isn’t already on your hard drive, you’'ll be asked to
insert one of the Windows Install disks. Put it into your floppy
drive (or into your CD-ROM if your Windows files came on a CD),
direct the computer to look at the proper drive, and click OK.

If the computer can'’t find the right driver on the disk, then return
to the Change System Settings dialog box, open the list of display
drivers, and select Other display.

This is when you’ll need the disks that came with your video
card. Put the disk with the Windows drivers for your video card
into your A: or B: drive (or CD-ROM drive if the files are on a CD).
Make sure the drive in this dialog box matches the drive with the
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disk, then click OK.

13. If it’s the right disk, a new list of drivers will appear. If it isn’t the
right disk, you’ll be prompted to change the disk. (You may need
to designate a directory as well, for example, A:\WIN31 instead of
just A:)

14. Choose the driver you want, and click Install. Next, click Restart
Windows, and you're ready to play Full Tilt!

Important Video Card Tips

Some video cards can only be set with special programs that come with
them. These programs must be installed onto your hard disk before they
can be used. Check the documentation that came with your card.

It’s possible that some of your current applications will require you to

switch back to 16-color mode, but most of them will work just fine in 256 ‘

colors.

If you don’t have the proper drivers for your video card, or need new
ones, there are several easy ways to get them:

The dealer who sold you your computer should have them or be able to
get them for you.

If you have a modem, you can download the drivers from the
manufacturers forums on most on-line services, or get them directly
from the manufacturer’s BBS.
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Sound (ard Troubleshooting

In order to hear Full Tilt!'s sound effects, your sound card must be
properly installed to work with Windows. If you don’t hear any sound
while using Full Tilt!, check the documentation that came with your
sound card for installation instructions.

Sound Card Hint

A quick way to check if your sound card is properly installed to work
with Windows is:

1. Open the Program Manager, double clock on the Control Panel
icon (it’s usually in the Main group), then double-click on the
Sound icon within the Control Panel.

2. Look at the list under the word “Files.” If the files with names
that end with “WAV” are grayed out, then you’ll need to reinstall
your sound card software.
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Hints and Tips for Higher Scores

There are four secrets to getting high scores in pinball:
1. Control the ball.
2. Control the ball.
3. Complete the missions, and
4. Control the ball.

In case you didn’t get the message, controlling the ball is the key to
pinball survival and success. As a beginner, you will have a lot of fun just
hitting the ball whenever it comes near a flipper. But as you progress,
you’ll want to gain more and more control so you can send the ball
where you want it to go.

Here are some tips from the experts:

In General

Many people, especially beginners, believe that pinball is a game of luck.
Although this is partly true (and there are very few instances in life
where luck doesn’t play some role), in modern games the luck factor is
much lower. The consensus among players today is that luck only
comprises 20-25% of pinball playing.

There are three main ways to improve your play.

1. As stated above, the most important thing is to learn to control
the ball. It may be tempting to flip every time the ball approaches
the flippers, but you stand a much better chance of hitting the
shot you want to hit if you have the patience to slow the ball
down as much as you can and shoot a controlled shot.
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Next comes aiming. Aiming is largely intuition and “feel” at first,
but eventually you will learn to visualize your target on the
flipper to make the ball go where you want it to go.

3. Finally, there is the art of nudging. Pinball is a physical game, and
a major portion of its attraction is the way you can have a direct
influence on the environment—something not usually possible in
a video game, but we allowed for it in Full Tilt! Pinball.
(ontrolling the Ball

The simplest way to catch a ball is to merely hold up a flipper when the
ball is heading toward it and hope it comes to rest in the “V” at the pivot
point of the flipper. This is a decent starting point, but most of the time
it is not sulfficient to totally stop the ball. Here are a few more advanced
ball control techniques:

The Dead Catch (also known as the Drop Catch)

This is one of the easiest catches to perform. Hold up a flipper
when the ball is heading toward it. Just as the ball gets to the
flipper, let the flipper go. This should cause the ball to
temporarily lose all of its momentum. The problem is that the
flipper is now lowered, so the ball will start to roll down it. With
a very slow moving ball, though, you are in a much better
position to make a controlled shot than trying to flail it in the
general direction you want it to go.

The Live Catch

This is probably the most valuable skill you can have. It’s not
easy, but it’s worth the effort to master. When a ball is rolling
toward a flipper, time your flip so that it meets the ball at the
very top of the flipper’s up position. If done right, the ball will
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lose all momentum and gracefully roll down the raised flipper to
a caught position. Even if this is not done exactly right, coming
close will often dampen the ball quite a bit making another live
catch attempt (or another kind of catch) much easier.

The Flipper Pass

Occasionally you will have the ball caught on a flipper, but the
ball has to be on the other flipper to make the shot you want.
You can get the ball to the other side by doing a quick flip: drop =
the flipper, raise it again right away, and hold it up. If your timing

is right, this should send the ball gently up and over to the other
flipper, where it can be easily caught. Of course, until you get the
timing right, you'll shoot a few balls off in random directions or ;
worse, lose them down the center drain. e

The Bounce Pass

Sometimes the best catch is no catch at all: when the ball |
approaches a flipper, just let it hit—don’t touch the flipper
button—and, depending on the angle, it may bounce over to the
other flipper, slowed down and ready for an easy catch. You'll
learn which angles work through practice. .

Aiming

Aiming is probably the hardest thing to actually teach someone—it just

takes a lot of practice. One good hint for beginners, though, is to try to
look at both ends of your shot. Visualize a line from where the ball is (or =
will be when you hit it) to your intended target. ¢

Once you are able to hit your target on a regular basis, it then becomes
time to concentrate only on the lower portion of the playfield. By now
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you should have a pretty good idea of where on the flipper the ball
needs to be when you flip it and where it will go afterwards. Once you
can keep your eyes focused at the bottom of the table, you'll lose fewer
balls down the drains. This is especially important during multiball,
when most of the activity is going on down around your flippers and
you'll need to make many quick shots, without having the luxury of
watching where each ball goes.

Nudging

Never be afraid to give the game a good shake every now and again.
Beginners may see people hitting, banging and shaking tables, and think
that the player is cheating. Far from it: pinball tables are designed to be
nudged—up to a certain point, of course.

' Nudging is probably the second most important aspect of pinball, next
 to flipping. It is a true art, to be mastered through practice. Nudging is
- only helpful if you do it right—nudge too hard and the game will tilt. You
should strive to get the maximum effect from the least amount of
movement.

The penalty for tilting is having your flippers go dead and forfeiting your
bonus. On some games, the bonus is worth quite a few points, on others
t is almost worthless. Keep track of your bonus and take it into account
when you decide whether to try saving a ball with a nudge. If the bonus
' is low, go for it. You've got nothing to lose.

One of the most common forms of nudging is the slap-save. When a ball
' looks as if it is heading straight down the middle, you can slap the
' flipper closest to the ball. (In Full Tilt! Pinball, the equivalent of the slap-
save is simultaneously hitting your controls for right flipper and left

bump or left flipper and right bump.) This will hopefully be enough force
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to move the table under the ball so that the flipper touches part of the
ball, to either get it back into play or over to the other flipper (where
you can flip it back into play or slap that side as well). Slapping first one
side then right away the other side can save more balls than you think.

Here’s another effective trick: when a ball is near an outlane, nudge the
ball against the outside edge of the playfield to get it out of the area
instead of trying to nudge it towards the center of the table. You'll get
better results.

Multiball Tips

Multiball is an entirely different story. Sometimes you will be able to
employ the tactics described above, but usually the action will be too
frenetic to play a very controlled game. ﬁ'

The best plan of action in multiball is to keep the number of balls flying
around down to a minimum. Some playfields will have places you can
shoot the ball to get it out of the way for a while. Other times, the only way
to reduce the number of balls is to hold one (or more) on one flipper while
you do your best to play with only the other flipper. This isn’t always
practical, but you can mix it up a little bit. For example, you may need to
shoot a shot on the left then a shot on the right. Depending on how the
shots are laid out, you may be able to make one shot, wait for the ball to
return to the flippers to control it again, then shoot the other ball.

If at all possible, you should try to keep at least one ball caught at all
times. Nothing is more maddening than losing all of your balls at once.
When another ball is heading towards the caught ball, just keep your
cool and see what happens. Either one of the balls will bounce nicely to
the other flipper, both balls will wind up on the same flipper, or in rare
circumstances both balls will wind up going out of control.
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When more than one ball is caught on a single flipper, you eventually
will have to separate them. Usually a quick flip (as in a flipper pass) will
be sufficient to get one ball off the flipper. The main objective is to
separate the balls, but you also want to try to keep one ball in a caught
position.

The only time you should sacrifice a caught ball is if you are about to
drain your next-to-last ball. Sometimes being able to flip at the right time
will be enough to save the drain-bound ball, but if that is not going to do
it, then you will need to try a pool-shot: try to aim the ball you have
caught at the draining ball to change its course. This may have the side-
effect of draining one (or possibly both) of the balls, but at least you
tried!

Summary

This overview should give you a good starting point for improving your
pinball play. Once you have these basic techniques down, you can
spend more time extending them and understanding when to use a given
method. And remember: having good technique is only half of the battle.
- Each game provides a new and unique challenge, requiring different
- kinds of shots and a new rule set to figure out. While it is generally easier

~ to succeed when you have the basic skills, you must use your brain as

- well to catch all of the strategies and nuances involved in mastering a
given table.
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Suggestions for Maximum Performance

While Full Tilt! Pinball will run on all the machines mentioned in the
Installation section above, the faster your machine, the better it runs. If
you find the game stalling or running slowly, try these steps:

1. If you're on a network, log off. Network services, including e-mail,
will take precedence over pinball, and mess up your timing.

2. Turn off the sounds in the Options menu. Loading and playing
the sound files is disk and processor intensive, and on some
machines will cause pauses in the action.

3. Turn off the music in the Options menu. These midi files aren’t as
processor intensive as the sounds, but can slow you down. m

4. If you are short on RAM, your computer may use virtual memory.
This will slow things way down. If Full Tilt! runs too slowly, play
it in a lower resolution. You can find this under Table Resolution
in the Options menu.
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A Brief History of Pinball

 SoWhy Is It Called Pinball?

The ancestors of the modern pinball game were much like Pachinko

~ machines. They were not upright like Pachinko machines, but they did

have many pins and holes in the playfield. Balls came down from the top
and scored a varying amount of points depending on which hole they
eventually fell into. This is probably how the term pin-ball came about.

- The Early Years

The coin-operated industry began in 1931 with the production of
Ballyhoo. It was built by Raymond Maloney, who later founded the Bally
Manufacturing Company. It was not until 1936, however, until the term
“pinball” was coined.

In 1934, the infamous tilt mechanism was devised. People realized they
could manipulate the game to their advantage by shaking it, so
manufacturers had to come up with a way to stop the cheating.
Supposedly, one of the ideas that did not make it into production was
pounding sharp pins or nails onto the side and bottom of the machine
(this was quickly rejected on the assumption that players would get so
mad, they’d really inflict some damage on the machine). One of the
earliest implementations involved a ball on a pedestal that would fall off
when the machine was moved around too much. On modern machines,
there are two tilt sensors: the standard movement tilt and the slam tilt.
Slam tilts are used to detect major abuse (such as slamming your hand
into the front of the coin door or dropping the machine) and are just a
couple of leaf switches that signal a slam when they touch each other.
The movement tilt is detected by a pendulum and bob mechanism that
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moves around inside a ring. A tilt (or tilt warning) occurs when the metal
pendulum rod touches the metal ring.

1947 was the big year. Humpty Dumpty—the first game with flippers—
was released by Gottlieb. The flippers were not set up as we know them
today, however. There were three sets of two flippers located at three
different spots going up the playfield. They were facing each other, as
flippers do today, but the pivot point was at the bottom of the flippers. :
In January 1948, a company called Genco placed the flippers at the
bottom of the playfield in their game Triple Action. The configuration
was still a little unusual: the flippers were facing outward, not inward.
The first game that had the flippers set up as we know and love them
today was probably Spot Bowler, a 1950 Gottlieb game.

If you have not seen one of these older games, you may be surprised at
the size of their flippers. They were probably about the size of 2 pinballs
in length, much like some of the small flippers used in today’s games
(such as the leftside flipper on The Addams Family). It was not until 1970
that games started using the longer flippers on a regular basis.

One of the darkest moments in pinball history came about on January
21, 1942. Pinball was banned in New York City because it was viewed as
a game of luck rather than a game of skill (ergo, playing pinball is
gambling!). To “celebrate” the ban, Mayor Fiorello Henry LaGuardia (as
in LaGuardia airport) smashed a number of machines in front of a largely
supportive crowd. The ban lasted until 1976. Free games (replays,
matches, etc.) continue to be illegal in New York City to this day,
although the law goes unenforced.

In 1960, the idea of an earnable extra ball first appeared in Gottlieb’s
Flipper. This was done in response to the laws of many areas that made
it illegal to award replays.

The first drop targets were introduced in Williams’ Vagabond in 1962.
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Modern Pinball

The next major change came along in 1975. The first non-relay-based
game, called Spirit of 76, was produced by Micro. It marked the
beginning of the switch from electromechanical to solid state games.
The first widely available solid state game (only 100 Spirit of 76’s were
made, mostly due to an unattractive playfield) was Freedom from Bally
in 1976. Many games in the 1976-1979 period were made in two versions
(both solid state and electromechanical) as manufacturers refined the
process of moving to the new technology.

In 1979, the first talking game was produced: Gorgar, from Williams. In
the early 1980s, many games started using magnets to let the player try
to save the ball (called magna-save by Williams). Black Knight and
Jungle Lord are two good examples of this.

The next major revolution in pinball was not until 1991, when Data East
came out with the first dot-matrix display in their game Checkpoint.
Starting around 1992, all games from all manufacturers have employed a
dot-matrix display.

~ So where are we today? Pinball has come a long way in the last six years
~ or so, particularly in complexity. And it will no doubt continue to

~ advance with the technology. One important advent in pinball history is

- the introduction of pinball simulations on home computers. Now that

_ the average home PC has good quality graphics and sound, plus high
resolution graphics and a lot of processing power, games like Full Tilt!
are possible.
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Even the makers of computerized virtual pinball tables don’t expect—or
want—them to totally replace the stand-alone “real” tables. There’s
nothing like standing at a full-size table and getting physical. But virtual
tables like Full Tilt! Pinball are great games, with the potential to create
tables that can’t even be built in the real world-simultaneous multiplayer
wonders, multilevel mazes and more. Besides, at $5,000 to $15,000 a
table for a new pinball game, these electronic ones are really worth their
weight in gold.

In summary, pinball is a great game with a glorious history. And as far as
the future goes, who knows what surprises are in store for us?
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